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1.  About these instructions for use
These instructions for use guide the user in utilizing the AltoStar® HAV RT-PCR Kit 1.5. 
Chapters 1–6 and 9–14 contain general information and instructions which apply 
to each workflow used with the AltoStar® HAV RT-PCR Kit 1.5. Chapter 7 gives 
instructions on how to use the product with the AltoStar® Automation System AM16 
(Hamilton; in the following summarized as AltoStar® AM16) with the AltoStar® 
Connect software (Version 1.7.4 or higher, Hamilton) for automated PCR setup and 
on the CFX96™ Deep Well Dx System* (Bio-Rad, in the following summarized as 
CFX96™ DW Dx) with the CFX Manager™ Dx software (Version 3.1, Bio-Rad) for 
real-time PCR. Chapter 8 gives instructions regarding how to use the AltoStar® HAV 
RT-PCR Kit 1.5 in conjunction with other nucleic acid extraction methods and real-
time PCR instruments. For details on the use of the AltoStar® AM16, the AltoStar® 
Connect software, the AltoStar® Purification Kit 1.5, the AltoStar® Internal Control 1.5 
and the CFX96™ DW Dx, refer to the respective instructions for use listed below: 

•	 AltoStar® Automation System AM16 Operator's Manual IVD (Hamilton) 

•	 AltoStar® Connect Software Manual IVD (Hamilton) 

•	 Instructions for use AltoStar® Purification Kit 1.5 

•	 Instructions for use AltoStar® Internal Control 1.5 

•	 CFX96™ Dx and CFX96™ Deep Well Dx Systems Operation Manual 
(Bio-Rad)

*	 “CFX96™ Deep Well Dx System” is the new brand name for the IVD version of the CFX96™ 
Deep Well Real-Time PCR Detection System (Bio-Rad).

Throughout this manual, the terms CAUTION and NOTE have the following 
meanings:

CAUTION

Highlights operating instructions or procedures which, if not followed 
correctly, may result in personal injury or impact product performance. 
Contact altona Diagnostics technical support for assistance.
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NOTE

Information is given to the user that is useful but not essential to the task 
at hand. 

Read the instructions for use carefully before using the product.

2.  Intended use
The AltoStar® HAV RT-PCR Kit 1.5 is an in vitro diagnostic test, based on real-time 
PCR technology, for the qualitative detection of hepatitis A virus (HAV) specific RNA 
in human plasma. It is intended to be used as an aid for diagnosis of HAV infection.

The results generated with the AltoStar® HAV RT-PCR Kit 1.5 have to be interpreted 
in conjunction with other clinical and laboratory findings. 

The AltoStar® HAV RT-PCR Kit 1.5 is intended for use by professional users trained 
in molecular biological techniques and in vitro diagnostic procedures.
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3.  Kit content
The AltoStar® HAV RT-PCR Kit 1.5 contains the following components:

Table   1: Kit components

Lid color Component Number of tubes Nominal volume 
[μl/tube]

Blue Master A1) 8 602)

Purple Master B1) 8 1803)

Red PC4) 2 250
White NTC5) 2 250

1)	Contains biological material of animal origin
2)	Contains an additional volume of 25 µl to compensate the dead volume of the AltoStar® 

AM16's liquid handling
3)	Contains an additional volume of 55 µl to compensate the dead volume of the AltoStar® 

AM16's liquid handling
4)	Positive Control
5)	No Template Control (Negative Control)

CAUTION

Before first use check the product and its components for completeness 
with respect to number, type and filling. Do not use a defective or 
incomplete product, product performance could be compromised.

The AltoStar® HAV RT-PCR Kit 1.5 contains enough reagents to perform 96 reactions 
in a maximum number of 8 runs.
 



11

AltoStar® HAV RT-PCR Kit 1.5

The product is shipped on dry ice. Upon receipt and before first use, check the 
product and its components for:

•	 Integrity 

•	 Completeness with respect to number, type and filling 

•	 Correct labeling 

•	 Expiration date

•	 Frozen state 

•	 Clarity and absence of particles

If one or more product components are not frozen upon receipt, if tubes have been 
compromised during shipment or are missing, contact altona Diagnostics technical 
support for assistance (see chapter 12. Technical support).

4.  Storage and handling
All reagents included in the AltoStar® HAV RT-PCR Kit 1.5 are ready-to-use solutions.

4.1  Storage
All components of the AltoStar® HAV RT-PCR Kit 1.5 must be stored at -25 °C to 
-15 °C upon arrival.

CAUTION

Improper storage conditions could compromise product performance.

CAUTION

Do not use products beyond the expiration date. The use of expired 
products could compromise product performance. 
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4.2  Handling

CAUTION

Do not exceed thaw-freeze-sequence and handling durations specified 
in these instructions for use, as this could compromise product 
performance.

CAUTION

Improper handling of product components and samples may cause 
contamination and could compromise product performance:
	- Do not interchange vial or bottle caps. 
	- Store positive and/or potentially positive material separated from the 

kit components.
	- Use separated working areas for sample preparation/reaction setup 
and amplification/detection activities. 

	- Always dispose gloves after handling positive and/or potentially 
positive material. 

	- Do not open the PCR plates and/or tubes post amplification.

CAUTION

Do not mix components from different kit lots. The use of different kit lots 
could compromise product performance.

4.2.1  Master A and Master B
After thawing, Master A and Master B are stable for 5 hours at up to +30 °C.

NOTE

If Master A and Master B were thawed but not used, they can be refrozen 
and thawed again once for later runs. If opened, discard the lids and use 
new lids to avoid contamination of the reagents.
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4.2.2  Positive Control and No Template Control
1.	 After thawing, the Positive Control (PC) and the No Template Control (NTC) 

are stable for 5 hours at up to +30 °C.

2.	 Discard the lids of the PC and NTC tubes at each use and use new lids to avoid 
contamination of the reagents. 

3.	 After use close the PC and NTC tubes with new lids and freeze them 
immediately.

4.	 Do not exceed the following thaw-freeze-sequence for each PC and NTC tube: 
Thaw 1 → Freeze 1 → Thaw 2 → Freeze 2 → Thaw 3 → Freeze 3 → Thaw 4

5.  Product description
The AltoStar® HAV RT-PCR Kit 1.5 is an in vitro diagnostic test for the qualitative 
detection of HAV specific RNA in plasma. 

It is based on real-time RT-PCR technology, utilizing reverse-transcriptase 
(RT) reaction to convert RNA into complementary DNA (cDNA), polymerase 
chain reaction (PCR) for the amplification of HAV specific target sequences and 
fluorescently labeled target specific probes for the detection of the amplified DNA.

In addition to the HAV RNA specific amplification and detection system the assay 
includes oligonucleotides for the amplification and detection of the internal control 
(in the following abbreviated as IC; AltoStar® Internal Control 1.5).

Probes specific for HAV RNA are labeled with the fluorophore FAM™. The probe 
specific for the IC is labeled with a fluorophore (JOE™) detectable in the e.g. VIC™ 
channel.

Using probes linked to distinguishable dyes enables the parallel detection of HAV 
specific RNA and the IC in corresponding detection channels of the real-time PCR 
instrument used.
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5.1  Background
Hepatitis A virus (HAV) is one of five hepatitis viruses known to infect humans. 
It belongs to the family of Picornaviridae and the genus Hepatovirus. It is a non-
enveloped and icosahedral virus and its genome consists of linear, positive-sense 
single-stranded RNA (ssRNA). HAV total genome size is approximately 7.5 kb in 
length.

HAV is primarily transmitted by the fecal-oral route through contact or smear 
infection. It is usually spread by drinking contaminated water or eating contaminated 
food (like shellfish), as well as by close contact with an already infected person. The 
virus is distributed worldwide. In developing countries nearly all individuals have 
a high risk of infection and had contact to HAV during their childhood. In more 
industrial developed regions like Europe and North America, infection risk is much 
lower since better sanitary standards are established. Following HAV infection 
permanent immunity is obtained.

After infection, first symptoms show after 14–28 days. Typical symptoms are 
fever, malaise, loss of appetite, diarrhea, nausea, dark colored urine and jaundice. 
Children that are infected often show no or only mild symptoms. However, adults 
often experience (severe) symptoms. In general mortality is low and infections 
with HAV does not turn into a chronic disease of the liver. There is no therapeutic 
treatment known for HAV infection but preventive vaccination is possible [1,2].

5.2  Component description

5.2.1  Master A and Master B
Master A and Master B contain all components (PCR buffer, reverse transcriptase, 
DNA polymerase, magnesium salt, primers and probes) to allow reverse transcription, 
as well as the PCR mediated amplification and target detection of HAV specific RNA 
and of the IC in one reaction setup.
 



15

AltoStar® HAV RT-PCR Kit 1.5

5.2.2  Positive Control
The PC contains standardized concentrations of HAV specific RNA. It is calibrated 
against the 3rd WHO International Standard for Hepatitis A Virus VL For Nucleic 
Acid Amplification Techniques (NIBSC code: 15/276). The PC is used to verify the 
functionality of the HAV specific amplification and detection systems included in the 
AltoStar® HAV RT-PCR Kit 1.5.

5.2.3  No Template Control
The NTC contains no HAV specific RNA but does contain the IC template. The 
NTC is used as negative control for the HAV RNA specific real-time RT-PCR and 
indicates possible contamination of Master A and Master B.

5.3  Workflows

5.3.1  AltoStar® Workflow
The AltoStar® Workflow comprises the following IVD products:

•	 AltoStar® Automation System AM16 (Hamilton)

•	 AltoStar® Connect software version 1.7.4 or higher (Hamilton)

•	 CFX96™ Deep Well Dx System (Bio-Rad) with CFX Manager™ Dx software 
version 3.1 (Bio-Rad)

The workflow includes the following steps:

1.	 Programming an AltoStar® run. 

2.	 Purification run on the AltoStar® AM16 using the AltoStar® Purification Kit 1.5 
and the AltoStar® Internal Control 1.5. 

3.	 RT-PCR setup run on the AltoStar® AM16 using the AltoStar® HAV RT-PCR 
Kit 1.5. 

4.	 Real-time RT-PCR run on a CFX96™ DW Dx.
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For further details on steps 3 and 4 of the workflow, refer to chapter 7. Using the 
AltoStar® HAV RT-PCR Kit 1.5 with the AltoStar® Workflow. All sample types and 
sample volumes specified for use with the AltoStar® Purification Kit 1.5 can be 
processed simultaneously on the AltoStar® AM16. Each sample can be analyzed 
with as many real-time PCR assays in parallel as the available eluate allows.

NOTE

Assays with differing PCR temperature profiles are automatically sorted 
to separate PCR plates. 

5.3.2  Other workflows
The AltoStar® HAV RT-PCR Kit 1.5 can be used with compatible workflows (manual 
or automated). Real-time PCR instruments that have been validated for use with 
the AltoStar® HAV RT-PCR Kit 1.5 are listed in chapter 5.3.2.2 Real-time PCR 
instruments. Use of alternative extraction procedures has to be validated by the 
user.

5.3.2.1  Nucleic acid extraction
The AltoStar® HAV RT-PCR Kit 1.5 can be used with nucleic acid extraction 
systems other than the AltoStar® AM16. Alternative procedures used for nucleic 
acid extraction have to be validated by the user. Refer to chapter 8.2.1 Sample 
preparation for instructions regarding how to use the AltoStar® Internal Control 1.5 
in combination with other extraction methods than the AltoStar® Purification Kit 1.5.
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5.3.2.2  Real-time PCR instruments
The AltoStar® HAV RT-PCR Kit 1.5 has been developed and validated with the 
following real-time PCR instruments:

•	 ABI Prism® 7500 SDS (Applied Biosystems)

•	 CFX96™ Deep Well Dx System (Bio-Rad)

•	 CFX96™ Dx System (Bio-Rad)

•	 LightCycler® 480 Instrument II (Roche)

•	 QuantStudio™ 5 Real-Time PCR System (Applied Biosystems)

•	 Rotor-Gene® Q5/6 plex Platform (QIAGEN)

Using one of the real-time PCR instruments listed above (except for the CFX96™ 
Deep Well Dx System), the PCR setup, the programming of the instrument as well 
as the data analysis have to be performed manually (for details see chapters 8.2.2 
Master mix setup to 8.2.5 Data analysis).

5.4  Samples

5.4.1  Sample types
The following sample types are validated for use with the AltoStar® HAV 
RT-PCR Kit 1.5:

•	 Human EDTA plasma

•	 Human citrate plasma

CAUTION

Do not use other sample types! The use of other sample types could 
compromise product performance.
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5.4.2  Sample collection and handling
Blood has to be collected with commercially available standard blood collection 
systems (e.g. Sarstedt, Becton Dickinson, Greiner or equivalent). Tube contents 
should be mixed directly after sample collection. The blood samples should be 
shipped cooled at +2 °C to +8 °C. Transport should occur following the local and 
national instructions for the transport of biological material. 

For generation of EDTA plasma, whole blood should be centrifuged according 
to the instructions provided by the manufacturer of the collection system within 
24 hours after collection. Before use EDTA plasma should not be stored for more 
than 48 hours at room temperature (+20 °C to +25 °C), 5 days at +2 °C to +8 °C or 
2 months at -25 °C to -15 °C.

CAUTION

Always treat samples as infectious and (bio-)hazardous material in 
accordance with safety and laboratory procedures. For sample material 
spills promptly use an appropriate disinfectant. Handle contaminated 
materials as biohazardous.

NOTE

Frozen storage of samples does not compromise kit performance. 
When working with frozen samples, make sure samples are completely 
thawed and properly mixed before use.
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6.  Warnings, precautions and limitations
•	 Before first use check the product and its components for completeness with 

respect to number, type and filling. Do not use a defective or incomplete 
product, product performance could be compromised.

•	 Improper storage conditions could compromise product performance.

•	 Do not use products beyond the expiration date. The use of expired products 
could compromise product performance. 

•	 Do not exceed thaw-freeze-sequence and handling durations specified in 
these instructions for use, as this could compromise product performance.

•	 Improper handling of product components and samples may cause 
contamination and could compromise product performance:

	◦ Do not interchange vial or bottle caps. 

	◦ Store positive and/or potentially positive material separated from the kit 
components.

	◦ Use separated working areas for sample preparation/reaction setup and 
amplification/detection activities. 

	◦ Always dispose gloves after handling positive and/or potentially positive 
material. 

	◦ Do not open the PCR plates and/or tubes post amplification.

•	 Do not mix components from different kit lots. The use of different kit lots could 
compromise product performance.

•	 Do not use other sample types! The use of other sample types could 
compromise product performance. 

•	 Always treat samples as infectious and (bio-)hazardous material in accordance 
with safety and laboratory procedures. For sample material spills promptly use 
an appropriate disinfectant. Handle contaminated materials as biohazardous.

•	 Storage of eluates under wrong conditions may lead to degradation of the 
HAV target sequence and could compromise product performance.

•	 Do not use an assay protocol version other than the one indicated on the 
2D barcode in these instructions for use. Using an incorrect assay protocol 
version could compromise product performance.

•	 A lack of centrifugation of the product components after thawing may cause 
contamination with reagent residues in the lids and could compromise product 
performance.
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•	 Do not reuse tube caps to avoid contamination of the reagents, as this could 
compromise product performance.

•	 As with any diagnostic test, results shall be interpreted in consideration of all 
clinical and laboratory findings.

•	 The presence of PCR inhibitors (e.g. heparin) could cause false negative or 
invalid results.

•	 Do not use different volumes of Master A and Master B for master mix setup 
than specified in these instructions for use, as this could compromise product 
performance.

•	 Do not exceed the PCR mix storage time, as this could compromise product 
performance.

•	 Do not mix up samples or sample IDs during PCR setup or transfer to the PCR 
instrument. This could lead to false positive or false negative results due to 
incorrect assignment of the samples.

•	 Do not use other cycling conditions than specified in these instructions for 
use, as this could compromise product performance.

•	 Do not use other control settings for data analysis than specified in these 
instructions for use, as this could cause incorrect IVD examination results. 

•	 In case the sample contains other pathogens than HAV, competition with the 
target amplification or cross-reactivities may occur, causing incorrect IVD 
examination results.

•	 Disposal of hazardous and biological waste shall comply with local and 
national regulations to avoid environmental contamination.

•	 Potential mutations within the target regions of the HAV genome covered 
by primers and/or probes used in the kit may result in failure to detect the 
presence of the pathogen.
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7.  Using the AltoStar® HAV RT-PCR Kit 1.5 with the 
AltoStar® Workflow

The following part of these instructions for use describes the use of the AltoStar® 
HAV RT-PCR Kit 1.5 in conjunction with the AltoStar® Workflow. The AltoStar® 
Workflow comprises different IVD products (AltoStar® AM16, the AltoStar® Connect 
software, the AltoStar® Purification Kit 1.5, the AltoStar® Internal Control 1.5 and 
the CFX96™ DW Dx). Use of those products is described in detail in the respective 
instructions for use.

•	 AltoStar® Automation System AM16 Operator's Manual IVD (Hamilton)

•	 AltoStar® Connect Software Manual IVD (Hamilton)

•	 Instructions for use AltoStar® Purification Kit 1.5

•	 Instructions for use AltoStar® Internal Control 1.5

•	 CFX96™ Dx and CFX96™ Deep Well Dx Systems Operation Manual 
(Bio-Rad)

7.1  Sample volume
The AltoStar® HAV RT-PCR Kit 1.5 is validated for nucleic acid purifications from a 
sample volume of 500 μl when using the AltoStar® AM16. Additional sample volume 
has to be provided to account for the dead volume of the sample tube used (see 
chapter 7.2 Sample tubes).

7.2  Sample tubes
Sample tubes suitable for use on the AltoStar® AM16 can be purchased from altona 
Diagnostics (7 ml tube with cap, 82 x 13 mm, VK000010). Other sample tubes can 
be tested for applicability by the user. For details, refer to the instructions for use of 
the AltoStar® Purification Kit 1.5.

7.3  Sample barcodes
For automated sample identification by the AltoStar® AM16 all sample tubes must 
be labeled with a suitable barcode. For details, refer to the instructions for use of the 
AltoStar® Purification Kit 1.5.
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7.4  Material and devices required but not provided for the 
AltoStar® Workflow

The material and devices shown in table 2 must be ordered from altona Diagnostics.

Table   2: Required material and devices

Material Description Order No.

AltoStar® Molecular Diagnostic 
Workflow

Product bundle containing the AltoStar® 
Automation System AM16, the AltoStar® 
Connect software (Version 1.7.4 or higher) 
and IT hardware

AM16

AltoStar® Detection

Product bundle containing the CFX96™ 
Deep Well Dx System with CFX 
Manager™ Dx Software (Version 3.1), a 
barcode scanner and IT hardware

DT16

AltoStar® Purification Kit 1.5
Nucleic acid isolation and purification 
chemistry for use with the AltoStar® 
Automation System AM16

PK15-16/ 
PK15-46

AltoStar® Internal Control 1.5
Nucleic acid extraction and PCR 
amplification and detection control

IC15-16/ 
IC15-46

PCR Plate
Semi-skirted, barcoded 96 multi-well plate 
with white wells

VK000005

PCR Plate Sealing Foil Sealing foil for the PCR plate VK000006

1,000 μl CO-RE Tips
1,000 µl filter tips for use with the 
AltoStar® Automation System AM16 

VK000007

300 μl CO-RE Tips
300 μl filter tips for use with the AltoStar® 
Automation System AM16

VK000008

Pooling Tube
Barcoded tube for pooling of PCR 
reagents

VK000002

Waste Bag
Autoclavable sterile bag for use with the 
AltoStar® Automation System AM16

VK000009

Screw Cap - red Screw cap for PC tubes VK000012

Screw Cap - blue Screw cap for Master A tubes VK000013

Screw Cap - purple Screw cap for Master B tubes VK000015
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Material Description Order No.

Screw Cap - white Screw cap for NTC tubes VK000016

Table   3: Additional laboratory material and devices 

Material Description Order No.

Plate Sealer
e.g. AltoStar® Plate Sealer VK000023

e.g. PX1 Plate Sealer (Bio-Rad) VK000033

7.5  General material and devices
•	 Vortex mixer

•	 Powder-free gloves (disposable)

•	 Centrifuge for centrifugation of the AltoStar® HAV RT-PCR Kit 1.5 components

•	 Centrifuge for centrifugation of PCR plates
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7.6  Procedure

7.6.1  Overview of the AltoStar® Workflow
The steps of the complete AltoStar® Workflow are summarized in table 4. Information 
on specific settings for use with the AltoStar® HAV RT-PCR Kit 1.5 are provided in 
chapter 7.6.2 Programming an AltoStar® run. For detailed instructions for steps 1–5, 
refer to the instructions for use of the AltoStar® Purification Kit 1.5, the AltoStar® 
Connect software and the AltoStar® AM16.

Steps 6–11 are described in more detail in chapters 7.6.3 Starting a PCR setup run 
to 7.6.10 Export of PCR results for manual result interpretation.

Table   4: Overview of the AltoStar® Workflow

Step Action

1. Start the AltoStar® AM16 •	 Switch on the AltoStar® AM16.
•	 Switch on the computer and the monitor.
•	 Start the AltoStar® Connect software.

2. Perform maintenance •	 In the menu bar click Application → Instrument 
Maintenance. 

	◦ If weekly maintenance is due, click Start Weekly 
Maintenance.

	◦ If daily maintenance is due, click Start Daily 
Maintenance.

•	 Follow the on-screen instructions for the maintenance 
process.

3. Program an AltoStar® 
run

•	 In the menu bar click Program Run → Program Run 
(AltoStar® Purification). Alternatively, go back to the 
Start screen and click the Program Run button.

•	 Enter samples or import from the LIMS.
•	 Select the following assay for the samples unless 

already imported from the LIMS:

	◦ AltoStar® HAV RT-PCR Kit 1.5

•	 Click the Create Run button in the tool bar to create 
the AltoStar® run.
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Step Action

4. Start a purification run •	 In the menu bar click Purification → Start 
Purification. Alternatively, go back to the Start screen 
and click the Start Purification button.

•	 Select the purification run to be started to display the 
samples included in the selected purification run.

•	 Prepare the purification reagents:

	◦ Ensure that the purification reagents to be used 
have the same loading number (except AltoStar® 
Internal Control 1.5) and are not expired.

	◦ If precipitates are visible in the Lysis Buffer, heat it 
(≤ +50 °C) until completely dissolved.

	◦ Thaw the IC (AltoStar® Internal Control 1.5) and 
vortex for 5 seconds.

	◦ Vortex the Magnetic Beads for 5 seconds without 
wetting the lid.

•	 Prepare the samples for the purification run to be 
started as described in the instructions for use of the 
AltoStar® Purification Kit 1.5.

•	 Click the Start Run button in the tool bar.
•	 Follow the loading dialogs and load the instrument 

accordingly.
•	 Confirm the Loading complete message with OK or 

wait 10 seconds.

The system will now perform the purification run 
automatically.

5. Finish the purification 
run

•	 Make sure the loading tray is empty and confirm the 
Run finished dialog with OK.

•	 Follow the instructions in the Maintenance dialog and 
confirm with OK.

•	 Seal and store the components of the AltoStar® 
Purification Kit 1.5 that can be reused.

The eluates in the unsealed eluate plate are stable at room 
temperature (max. +30 °C) for a total of 4 hours.

•	 If the associated PCR setup run is not started right 
away, seal the eluate plate with an Eluate Plate Sealing 
Foil and store at +2 °C to +8 °C for up to 24 hours.

•	 View the purification run results to confirm successful 
processing of each sample.
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Step Action

6. Start a PCR setup run •	 In the menu bar, click PCR Setup → Start PCR Setup. 
Alternatively, go back to the Start screen and click the 
Start PCR Setup button. 

•	 Select the PCR setup run to be started in order to 
display the eluate plate and reagents included in the 
selected PCR setup run.

•	 Prepare the PCR reagents:

	◦ Ensure that masters and controls to be used are 
from the same kit lot and are not expired.

	◦ Thaw the required amount of master and control 
tubes, vortex briefly and spin down in a centrifuge.

•	 If the eluate plate is sealed, briefly centrifuge the plate 
and unseal carefully.

•	 Click the Start Run button in the tool bar.
•	 Follow the Loading dialog and load the instrument 

accordingly.
•	 Confirm the Loading complete message with OK or 

wait 10 seconds.

The system will now perform the PCR setup run 
automatically. 

7. Finish the PCR setup 
run

•	 Make sure the loading tray is empty and confirm the 
Run finished dialog with OK.

•	 Follow the instructions in the Maintenance dialog and 
confirm with OK.

•	 Close and store the components of the AltoStar® HAV 
RT-PCR Kit 1.5 that can be reused.

•	 View the PCR setup run results to confirm successful 
processing of each sample.

8. Seal the PCR plate •	 Seal the PCR plate with a PCR Plate Sealing Foil.
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Step Action

9. Start the PCR run •	 Switch on the CFX96™ DW Dx, the attached computer 
and the monitor.

•	 Start the CFX Manager™ Dx software.
•	 Open the CFX96™ DW Dx.
•	 Centrifuge the PCR plate and insert it into the CFX96™ 

DW Dx.
•	 Select File → Open → LIMS File… from the menu 

bar.
•	 Scan the barcode of the PCR plate with the handheld 

barcode scanner.
•	 Close the CFX96™ DW Dx.
•	 Click the Start Run button to start the PCR run. Name 

and save the PCR run file.

The CFX96™ DW Dx will now perform the PCR run 
automatically.

10. Separate assays for 
individual analysis

•	 Separate all assays in the PCR run into distinct well 
groups.

11. Analyze the data and 
interpret the PCR run 
results

For each well group individually:

•	 Perform baseline correction in all wells for all detection 
channels used.

•	 Exclude wells with irregular PCR signals.
•	 Set the thresholds of all detection channels according 

to the controls.
•	 Exclude wells containing invalid data.
•	 Generate the LIMS result file for export of results to 

the LIMS.
•	 Generate the result report for manual result 

interpretation.

CAUTION

Storage of eluates under wrong conditions may lead to degradation of 
the HAV target sequence and could compromise product performance.
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7.6.2  Programming an AltoStar® run
For detailed information on starting an AltoStar® run, refer to the instructions for use 
of the AltoStar® Purification Kit 1.5, the AltoStar® Connect software and the AltoStar® 
AM16. Specific settings for use with the AltoStar® HAV RT-PCR Kit 1.5 are listed 
below:

•	 PC and NTC are selected.

•	 The required sample volume is 500 μl plus the dead volume for the respective 
sample tube (see chapters 7.1 Sample volume and 7.2 Sample tubes).

•	 The required eluate volume for the AltoStar® HAV RT-PCR Kit 1.5 is 10 μl.

•	 Make sure that the correct assay protocol version is used for the run. For 
information on the current protocol version see chapter 16. Assay protocol 
for the AltoStar® Connect software and information for LIMS integration. The 
respective assay protocol is encoded in the 2D barcode displayed there. 
For information on purification and assay protocol import into the AltoStar® 
Connect software, refer to the respective instructions for use.

CAUTION

Do not use an assay protocol version other than the one indicated on 
the 2D barcode in these instructions for use. Using an incorrect assay 
protocol version could compromise product performance.

7.6.3  Starting a PCR setup run
1.	 Select PCR Setup → Start PCR Setup in the menu bar. Alternatively, go back 

to the Start screen of the AltoStar® Connect software and select the Start PCR 
Setup button. The Start PCR Setup Run screen is displayed.

The pending PCR setup runs are displayed in the Programmed PCR Setup Runs 
table on the left side of the screen.
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2.	 Select the PCR setup run to be started in the Programmed PCR Setup Runs 
table. 

•	 The samples included in the selected PCR setup run are displayed in the 
table on the top right side of the screen (Samples in selected PCR Setup 
Run). 

•	 The controls required for the selected PCR setup run are displayed in 
the table on the middle right side of the screen (Controls in selected PCR 
Setup Run).

•	 The number of master tubes required for the selected PCR setup run is 
displayed in the table on the bottom right side of the screen (Required 
master tubes for the selected PCR Setup Run).

NOTE

The number of prioritized samples in a PCR setup run is displayed in 
the column No. of prioritized Samples. Conduct PCR setup runs with 
prioritized samples first to facilitate fastest processing of prioritized 
samples.

Before clicking the Start Run button in the tool bar, prepare the required reagents 
as described in chapter 7.6.3.1 Preparing reagents for a PCR setup run. If the eluate 
plate required for the selected PCR setup run has been sealed for storage prepare it 
as described in the instructions for use of the AltoStar® Purification Kit 1.5. 

7.6.3.1  Preparing reagents for a PCR setup run
1.	 Thaw the required controls and the required number of master tubes completely 

at room temperature (max. +30 °C). 

2.	 Mix the reagents by gentle vortexing. 

3.	 Centrifuge the tubes briefly to remove drops from the lid.

CAUTION

A lack of centrifugation of the product components after thawing 
may cause contamination with reagent residues in the lids and could 
compromise product performance.
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7.6.3.2  Loading the AltoStar® AM16 for a PCR setup run
For detailed information regarding the loading process, refer to the instructions for 
use of the AltoStar® AM16 and the AltoStar® Connect software.

1.	 Click the Start Run button in the tool bar of the Start PCR Setup Run screen 
to display the Loading dialog.

The Loading dialog consists of a visual representation of the AltoStar® AM16 
deck at the top and a table specifying the carriers, the respective tracks on the 
AltoStar® AM16 deck for each carrier, the material to be loaded onto each carrier 
and comments with respect to the carrier loading.

NOTE

To visualize the position of an item on a carrier and the position of the 
carrier on the AltoStar® AM16 deck, select the respective row of the table 
in the Loading dialog.

The position of the item and its carrier is visualized:

	- Highlighted in red in the visual representation of the instrument deck
	- On the AltoStar® AM16 by flashing loading lights above the tracks 

where the selected carrier must be placed

2.	 Load the required material, the prepared eluate plate and the prepared 
reagents onto the suitable carriers.

•	 Exchange only completely empty 1,000 μl tip racks for completely full 
1,000 μl tip racks on the tip carrier.

•	 Exchange only completely empty 300  μl tip racks for completely full 
300 μl tip racks on the tip and plate carrier.

NOTE

Exchange of tip racks, which are not completely empty as well as 
handling of individual tips may interfere with the automatic tip 
management and cause run aborts.

•	 Place the required eluate plate with well A1 to the left of the black plate 
position.
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•	 Place a PCR plate with well A1 to the left of the silver front plate position.

•	 Load a tube carrier 24 with one unused pooling tube for each assay in the 
PCR setup run.

•	 Gently push the tubes all the way to the bottom of the carrier and rotate the 
tubes until the tube barcodes are visible through the carrier window.

•	 Load the reagent tube carrier 32 with the assay components required for 
the PCR setup run.

•	 Gently push the tubes all the way to the bottom of the carrier and rotate the 
tubes until the tube barcodes are visible through the carrier window.

NOTE

The position of the individual tubes on the carriers is arbitrary.

NOTE

The volume of the loaded components is not checked by the system prior 
to processing. Insufficient component volume will prevent successful 
PCR setup for the affected assay. 

NOTE

Starting a PCR setup run with lids still on the tubes may cause the run 
to abort during processing. 

3.	 Load the carriers with the carrier barcode towards the rear facing right.

4.	 Insert populated carriers into the respective tracks between the front and rear 
slide blocks of the loading tray until they touch the stop hooks on the far side 
of the loading tray.

NOTE

Pushing the carriers past the stop hooks may damage the instrument 
and interfere with the loading process.

5.	 Check that the tip eject sheet and the tip waste container are in the correct 
position and a new waste bag is placed in the container.
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6.	 Click OK in the Loading dialog to proceed with the loading process.

NOTE

By clicking Cancel the PCR setup run will be canceled, but it can be 
started again (see chapter 7.6.3 Starting a PCR setup run). 

The AltoStar® AM16 draws the carriers into the instrument and performs barcode 
verification.

NOTE

The AltoStar® AM16 automatically verifies:

	- Correct type and localization of the loaded carriers
	- Correct identity and position of the items loaded on the carriers
	- Lot congruence of the components of the individual AltoStar® assay 

kits
	- Non-expiry of all loaded AltoStar® assay components
	- Correct positioning of the tip eject sheet

If any of these checks fail, the user is prompted with a message dialog specifying 
the problem at hand and instructions to correct the issue accordingly. For further 
information regarding error handling, refer to the instructions for use of the AltoStar® 
Connect software.

NOTE

Altering positions of any loaded item after the carrier has been drawn 
into the instrument may result in the abort of the PCR setup run and/or 
damage to the instrument.

When all checks have passed the Loading complete dialog is displayed.

7.	 Confirm the Loading complete dialog by clicking OK or wait 10 seconds for the 
automatic start of the process.
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NOTE

By clicking Cancel the PCR setup run will be canceled, but it can be 
started again (see chapter 7.6.3 Starting a PCR setup run).

The PCR setup run is started and will be conducted without user intervention.

7.6.3.3  During the PCR setup run
No further user interaction is required until the PCR setup run has finished. The 
Processing Status screen is displayed showing the status of the PCR setup run and 
the estimated time remaining.

NOTE

Pushing or pulling carriers or the door of the AltoStar® AM16 during a 
PCR setup run may abort the run.

7.6.4  End of the PCR setup run
At the end of the PCR setup run the Run finished dialog is displayed.

1.	 Make sure that the loading tray is empty.

2.	 Confirm the Run finished dialog by clicking OK.

The AltoStar® AM16 will unload the carriers. Make sure not to stand in the way of 
the unloading carriers.

After unloading the Maintenance dialog is displayed.

3.	 Follow the instructions of the Maintenance dialog.

The table of the dialog displays the number of reactions in the master tubes that 
were not used in the PCR setup run.
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4.	 If another PCR setup run using the currently loaded eluate plate is to be started 
right away, the eluate plate can remain unsealed on the carrier position. If this 
is not the case, seal and store the eluate plate. For further information, refer to 
the instructions for use of the AltoStar® Purification Kit 1.5.

NOTE

The eluates in the eluate plate are stable at room temperature (max. 
+30 °C) for a total of 4 hours after completion of the purification run.

5.	 Close reagent tubes with suitable unused tube caps.

CAUTION

Do not reuse tube caps to avoid contamination of the reagents, as this 
could compromise product performance.

6.	 Store reagents for reuse as described in chapter 4.2 Handling. 

7.	 Dispose of the used materials (see chapter 10. Disposal). 

8.	 Confirm the Maintenance dialog by clicking OK.

7.6.4.1  PCR setup run results
The PCR setup run results are saved in the AltoStar® Connect software.

1.	 Click PCR Setup → PCR Setup Results in the menu bar to access the Results 
screen.

The Results screen displays a table with all samples used in the latest PCR setup 
run and a column Status at the right showing if the PCR setup process for a given 
sample was conducted completely (see table 5).
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Table   5: PCR setup run results

Status PCR setup run result

Processed
•	 The eluate was successfully processed in the PCR setup run.
•	 The resulting RT-PCR mix is ready for use in a PCR run. 

Error
•	 The eluate was not processed successfully.
•	 The respective RT-PCR mix will be automatically omitted in the 

following PCR analysis. 

2.	 To view the results of prior PCR setup runs, click the Load button in the menu 
bar, select the desired PCR setup run from the list in the opening Load Results 
dialog and click OK.

3 PCR setup run result files are automatically generated by the AltoStar® Connect 
software:

•	 A LIMS file (.xml) to pass detailed information about the PCR setup run 
including results back to the LIMS 

•	 A report (.pdf) containing detailed information about the PCR setup run 
including results for documentation purposes 

•	 A cycler file (.plrn) for automatic programming of the CFX96™ DW Dx

These files are saved to the location specified in the system settings of the AltoStar® 
Connect software.

NOTE

PCR setup run result files can be generated again by loading the 
respective PCR setup run and clicking the Create LIMS File button to 
generate the LIMS file, the Create Report button to generate the report 
or the Create Bio-Rad Cycler File button to generate the cycler file.
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7.6.5  Sealing of the PCR plate
After completion of the PCR setup run, the PCR plate must be sealed with a PCR 
Plate Sealing Foil. It is recommended to use the AltoStar® Plate Sealer [4s3™ Semi-
Automatic Sheet Heat Sealer (4titude)] or the PX1 PCR Plate Sealer (Bio-Rad). 
The suitability of plate sealers other than the recommended plate sealers has to be 
evaluated by the user.

If one of the recommended plate sealers is used for sealing, proceed as follows:

1.	 Switch on the plate sealer and make sure that the plate adapter is not in the 
drawer.

2.	 Ensure that the settings of the plate sealer are as follows:

Table   6: Settings of the plate sealer

Plate sealer Settings

Temperature [°C] Time [s]

AltoStar® Plate Sealer 
[4s3™ Semi-Automatic 
Sheet Heat Sealer (4titude)]

170 2

PX1 PCR Plate Sealer 
(Bio-Rad)

175 3

3.	 Wait until the set temperature is reached. This may take several minutes.

4.	 Place the PCR plate on the plate adapter of the plate sealer.

5.	 Place one PCR Plate Sealing Foil on the PCR plate so that the print ‘THIS 
SIDE UP’ is readable. Make sure that all wells of the PCR plate are covered 
with foil and no well is obscured by the writing.

NOTE

Operating the plate sealer without the plate adapter placed in the 
drawer may render the sealer nonfunctional. In this case, contact altona 
Diagnostics technical support for assistance (see chapter 12. Technical 
support).
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NOTE

If the PCR Plate Sealing Foil or the frame is placed incorrectly, the foil 
may stick to the heating plate within the plate sealer during sealing. This 
will render the sealer nonfunctional. In this case, or if the sealing step 
has been initiated without a PCR Plate Sealing Foil, let the plate sealer 
cool down to room temperature and contact altona Diagnostics technical 
support for assistance (see chapter 12. Technical support).

6.	 Assemble the sealing frame on top to hold down the sealing foil.

7.	 Open the drawer by pressing the Operate*/ ** button.

8.	 Place the assembly consisting of the plate adapter, the PCR plate, the PCR 
Plate Sealing Foil and the sealing frame into the plate sealer and press the 
Operate*/ ** button.

9.	 The drawer closes automatically, seals for the set time and reopens 
automatically.

10.	Take the sealed PCR plate and the plate adapter out of the plate sealer and 
close the plate sealer by pressing the Close*/ ** button.

*	 AltoStar® Plate Sealer [4s3™ Semi-Automatic Sheet Heat Sealer (4titude)]
**PX1 PCR Plate Sealer (Bio-Rad)

7.6.5.1  PCR mix stability
After completion of the PCR setup run the RT-PCR mix in the sealed PCR plate is 
stable at room temperature (max. +30 °C) for 30 minutes.

CAUTION

Do not exceed the PCR mix storage time, as this could compromise 
product performance.
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7.6.6  Starting a PCR run
The PCR run is performed on a CFX96™ DW Dx under control of the CFX 
Manager™ Dx software.

1.	 Switch on the CFX96™ DW Dx, the attached computer and the monitor. 

2.	 Start the CFX Manager™ Dx software. 

3.	 In the menu bar of the CFX Manager™ Dx software select File → Open → 
LIMS File… to open the Open LIMS File dialog.

4.	 In the opening Open LIMS File dialog, make sure that the cursor is blinking in 
the File name field at the bottom. If it is not, click into the File name field.

5.	 Scan the PCR plate barcode with the handheld barcode scanner to automatically 
select and open the correct LIMS file. The Run Setup dialog is displayed.

NOTE

All parameters required for the start of the PCR run are transferred 
automatically from the AltoStar® Connect software to the CFX96™ DW 
Dx by means of the cycler file.

6.	 Click the Open Lid button in the Run Setup dialog to open the lid of the 
CFX96™ DW Dx.

7.	 Briefly centrifuge the sealed PCR plate to ensure all liquid is at the bottom of 
the wells. 

8.	 Insert the sealed PCR plate into the heating block of the CFX96™ DW Dx with 
well A1 to the left side. 

9.	 Close the CFX96™ DW Dx by clicking the Close Lid button in the Run Setup 
dialog. 

10.	Start the PCR run by clicking the Start Run button in the Run Setup dialog.
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7.6.6.1  During the PCR run
No user interaction is required until the PCR run has finished. The Run Details dialog 
is displayed showing the status of the PCR run and the estimated time remaining.

NOTE

Opening the lid of the CFX96™ DW Dx during a PCR run by operating 
the button at the front of the lid or by clicking Open Lid in the Run 
Details dialog will abort the run and void all results.

At the end of the PCR run the Data Analysis window is displayed, which shows the 
amplification curves, the plate layout and the results.

7.6.6.2  Assigning assays to well groups
The AltoStar® Workflow processes one or several PCR assays simultaneously on 
one PCR plate. However, each assay must be analyzed separately by the user 
according to the instructions for use of the respective assay.

To this end, all assays on a PCR plate must be assigned to individual well groups in 
the CFX Manager™ Dx software by the user.
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1.	 In the Data Analysis window click the Plate Setup button in the tool bar and 
select View/Edit Plate. The Plate Editor dialog is displayed (see figure 1).

Figure   1: Plate Editor dialog

2.	 In the Plate Editor dialog click Well Groups… in the tool bar. The Well Groups 
Manager dialog is displayed (see figure 2).

3.	 Click the Add button. 

4.	 Type the name of the first assay in the text box.
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5.	 Select all wells in the PCR plate area that belong to the first assay (see figure 2). 
The wells belonging to an individual assay can be identified in the Plate Editor 
dialog by the entry in the Biological Set field.

Figure   2: Well Groups Manager dialog

6.	 Repeat steps 3–5 for all assays on the PCR plate. 

7.	 Confirm well group assignment by clicking OK. The Well Groups Manager 
dialog closes. 

8.	 Close the Plate Editor dialog by clicking OK. 

9.	 Confirm to apply the changes by clicking Yes.
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7.6.7  PCR data analysis
The results of all assays (well groups) on the PCR plate have to be analyzed in the 
sequence depicted in figure 3.

Figure   3: PCR Data Analysis process

In the Data Analysis window ensure to select the Well Group of the AltoStar® HAV 
RT-PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right next to 
the Well Group button (see figure 4) of the toolbar. Do not use the “All Wells” Well 
Group. The selection in figure 4 is used as a general example view.
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Before analyzing the results, ensure that the well group of the AltoStar® HAV 
RT-PCR Kit 1.5 contains all of the AltoStar® HAV RT-PCR Kit 1.5 wells and no wells 
of other assays.

Figure   4: Well Group button and Well Group drop-down menu

NOTE

Combined analysis of more than one assay may lead to incorrect results.

CAUTION

As with any diagnostic test, results shall be interpreted in consideration 
of all clinical and laboratory findings.

7.6.7.1  Baseline correction
The baseline settings used by the CFX Manager™ Dx software may have to be 
corrected for individual wells of the assay (Well Group) under analysis.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HAV RT-PCR Kit 1.5. Therefore, click on the Well Group drop-down menu 
right next to the Well Group button (see figure 4) of the toolbar.

2.	 At the left side of the Data Analysis window tick only the FAM checkbox for the 
HAV target detection channel. 

3.	 In the menu bar of the Data Analysis window click Settings → Baseline 
Threshold… to open the Baseline Threshold dialog (see figure 5). 

4.	 Click the ◊ symbol in the Baseline End column header once to sort the table 
by ascending Baseline End values. 
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5.	 Select all lines that show a Baseline End value of 1–9 (see figure 5).

Figure   5: Baseline Threshold dialog

6.	 Set the value in the End: field to 45 for the selected lines (see figure 5). 

7.	 Confirm the settings by clicking OK. 

8.	 At the left side of the Data Analysis window untick the FAM checkbox and tick 
only the VIC checkbox for the IC target detection channel. 

9.	 Repeat steps 3–7 for the VIC™ (IC) detection channel.
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7.6.7.2  Exclusion of irregular PCR signals
Valid results can only be derived from PCR signals that are free of signal artefacts, 
which may be caused e.g. by impurities or bubbles in the RT-PCR mix. PCR signals 
that contain signal artefacts have to be excluded by the user.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HAV RT-PCR Kit 1.5. Therefore, click on the Well Group drop-down menu 
right next to the Well Group button (see figure 4) of the toolbar. 
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2.	 Identify wells with irregular PCR signals (linear signal increase, signal spikes, 
etc.) in any of the FAM™ (HAV target) and the VIC™ (IC) detection channels 
(see figure 6).

Figure   6: Data Analysis window: irregular PCR signal
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3.	 Click each affected well with the right mouse button and select Well... → 
Exclude from Analysis (see figure 7).

Figure   7: Data Analysis window: exclude well from analysis
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4.	 The selected well is excluded from the analysis. No results will be generated 
for this well (see figure 8).

Figure   8: Data Analysis window: excluded well
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7.6.7.3  Setting of thresholds
The thresholds for the FAM™ (HAV target) and the VIC™ (IC) detection channels 
have to be set manually by the user according to the signals of the controls.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HAV RT-PCR Kit 1.5. Therefore, click on the Well Group drop-down menu 
right next to the Well Group button (see figure 4) of the toolbar. 
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2.	 At the left side of the Data Analysis window tick only the VIC checkbox for the 
detection channel of the IC (see figure 9).

Figure   9: Data Analysis window: setting the VIC™ threshold
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3.	 Select only the NTC well in the plate view of the Data Analysis window (see 
figure 9). 

4.	 Drag the threshold into the exponential area of the NTC signal (see figure 9).

NOTE

The NTC contains the IC template, which leads to an IC signal in a valid 
NTC well.

5.	 At the left side of the Data Analysis window untick the VIC checkbox and tick 
the FAM checkbox for the detection channel of the HAV target (see figure 10).
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Figure   10: Data Analysis window: setting the FAM™ threshold

6.	 Select only the wells containing the NTC and the PC in the plate view of the 
Data Analysis window (see figure 10). 

7.	 Drag the threshold well above the signal of the NTC into the exponential area 
of the PC signal (see figure 10).
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7.6.8  Validity of PCR results

7.6.8.1  Exclusion of wells containing invalid data
Wells that do not contain valid data have to be excluded from result generation by 
the user.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HAV RT-PCR Kit 1.5. Therefore, click on the Well Group drop-down menu 
right next to the Well Group button (see figure 4) of the toolbar.

2.	 Identify all wells containing invalid data. A well is invalid if any of the following 
conditions apply:

a)	 The complete run is invalid (see chapter 7.6.8.2 Validity of a diagnostic 
PCR run).

b)	 The well data does not meet the control conditions for a valid result (see 
chapter 7.6.8.3 Validity of results for a sample).
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3.	 Click each well containing invalid data according to chapters 7.6.8.2 Validity of 
a diagnostic PCR run to 7.6.8.3 Validity of results for a sample with the right 
mouse button and select Well... → Exclude from Analysis (see figures 11 
and 12).

Figure   11: Data Analysis window: invalid well
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Figure   12: Data Analysis window: exclude invalid well from analysis

The selected well is excluded from the analysis. No results will be generated for 
this well.
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7.6.8.2  Validity of a diagnostic PCR run
A diagnostic PCR run is valid, if the following control conditions are met:

Table   7: Control conditions for a valid PCR run

Control Detection channel

FAM™  
(HAV target)

VIC™ 
(IC)

PC + Not applicable

NTC - +

A diagnostic PCR run is invalid, if:

•	 The run has not been completed.

•	 Any of the control conditions for a valid diagnostic PCR run are not met.

In case of an invalid diagnostic PCR run, exclude all wells from the analysis and 
repeat the AltoStar® run starting from the original samples.

7.6.8.3  Validity of results for a sample
The result for an individual sample is invalid, if the signals in both the VIC™ (IC) 
detection channel and the FAM™ (HAV target) detection channel are negative (see 
table 8). In case of an invalid result for a sample, exclude the well from the analysis 
and repeat testing from the original sample or collect and test a new sample.
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Table   8: Result validity

Detection channel
Result validity

FAM™ (HAV target) VIC™ (IC)

+ + Valid result

+ - Valid result* 

- + Valid result

- - Invalid result

*	 Detection of the IC is not required when the HAV target is detected. A high HAV RNA load in 
the sample can lead to a reduced or absent IC signal.

7.6.9  Export of PCR results for automated result interpretation
To make the PCR run results available to a connected LIMS for automated result 
interpretation they need to be exported in the form of a LIMS result file (.csv).

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HAV RT-PCR Kit 1.5. Therefore, click on the Well Group drop-down menu 
right next to the Well Group button (see figure 4) of the toolbar.

2.	 Ensure that all steps of the analysis process (see chapters 7.6.7.1 Baseline 
correction to 7.6.8.1 Exclusion of wells containing invalid data) have been 
completed for the well group of the AltoStar® HAV RT-PCR Kit 1.5.

3.	 In the menu bar of the Data Analysis window click Export → Export All Data 
Sheets to open the Browse For Folder dialog.

4.	 In the Browse For Folder dialog specify the location for the LIMS result files to 
be generated and click OK.

NOTE

The LIMS integration has to be implemented according to the 
specifications of altona Diagnostics. For information regarding LIMS 
integration, see chapter 16. Assay protocol for the AltoStar® Connect 
software and information for LIMS integration and/or contact altona 
Diagnostics technical support (see chapter 12. Technical support).
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NOTE

Saving results of more than one assay (well group) from a PCR run in 
the same folder leads to replacement of the LIMS result files of the first 
assay (well group) with the LIMS result files of the second assay (well 
group). In this case the LIMS result files of the first assay (well group) 
can be exported again.

7.6.10  Export of PCR results for manual result interpretation
If the results are not passed to a LIMS for automatic result interpretation, the result 
interpretation has to be performed manually by the user. To this end the analysis 
results of each assay (well group) need to be exported in the form of a report.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HAV RT-PCR Kit 1.5. Therefore, click on the Well Group drop-down menu 
right next to the Well Group button (see figure 4) of the toolbar. 

2.	 At the left side of the Data Analysis window tick the VIC checkbox as well as 
the FAM checkbox.

3.	 Ensure that all steps of the analysis process (see chapters 7.6.7.1 Baseline 
correction to 7.6.8.1 Exclusion of wells containing invalid data) have been 
completed for the well group of the AltoStar® HAV RT-PCR Kit 1.5.

4.	 In the menu bar of the Data Analysis window click Tools → Reports... to open 
the Report dialog.
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5.	 Ensure that at least the following content is selected for report generation in the 
upper left part of the Report dialog (see figure 13):

Figure   13: Report dialog

6.	 Select or deselect additional content of the report by ticking the respective 
check boxes as required. 

7.	 In the menu bar of the Report dialog click File → Save As... to open the Save 
Report dialog.

8.	 In the Save Report dialog specify the name and location for the report file to be 
generated and click Save.

7.6.10.1  Manual interpretation of results
1.	 Open the report file generated for the well group of the AltoStar® HAV RT-

PCR Kit 1.5 (see chapter 7.6.10 Export of PCR results for manual result 
interpretation). 

2.	 Refer to the Quantification Data table in the report (see figure 14). The table 
comprises 2 rows for each Sample – one for the Target HAV and one for the 
Target Internal Control.
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Figure   14: Report: Quantification Data

Qualitative results would be marked by the term qualitative in the Well Note column 
of the Quantification Data table.

3.	 Identify each row with the Target HAV and the term qualitative in the Well Note 
column.

4.	 In these rows, refer to the Cq column for the result of the respective Sample. 

5.	 Refer to table 9 for interpretation of results.

Table   9: Result interpretation

Threshold cycle (Cq) of the HAV target Result interpretation

1–45 HAV specific RNA detected.

N/A
No HAV specific RNA detected. Sample 
does not contain detectable amounts of HAV 
specific RNA.
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8.  Using the AltoStar® HAV RT-PCR Kit 1.5 with other real-
time PCR instruments than the CFX96™ Deep Well Dx 
System

In addition to the CFX96™ DW Dx the AltoStar® HAV RT-PCR Kit 1.5 has been 
validated with other real-time PCR instruments (see chapter 5.3.2.2 Real-time PCR 
instruments). The following chapters 8.1 Material and devices required but not 
provided and 8.2 Procedure describe how to use the AltoStar® HAV RT-PCR Kit 1.5 
with these instruments.

8.1  Material and devices required but not provided
The following instruments and materials are required:

•	 General materials and devices (see chapter 7.5 General material and devices)

•	 CFX96™ Deep Well Dx System (Bio-Rad)

	◦ 96-well PCR plates and sealing foil (details see table 2)

•	 CFX96™ Dx System (Bio-Rad)

	◦ 96-well PCR plates and sealing foil (details see table 2)

•	 Rotor-Gene® Q5/6 plex Platform (QIAGEN)

	◦ 0.1 ml strip tubes and lids [STRIP Tubes 0.1 ml for Rotor-Gene® cyclers 
(LTF Labortechnik) or equivalent]

•	 QuantStudio™ 5 Real-Time PCR System and ABI Prism® 7500 SDS (Applied 
Biosystems)

	◦ 96-well PCR plates and sealing foil [MicroAmp™ Optical 96-Well Reaction 
Plate and MicroAmp™ Optical Adhesive Film (Applied Biosystems) or 
equivalent]

•	 LightCycler® 480 Instrument II (Roche)

	◦ 96-well PCR plates and sealing foil [LightCycler® 480 Multiwell Plate 96, 
white and LightCycler® 480 Sealing Foil (Roche) or equivalent]



62

AltoStar® HAV RT-PCR Kit 1.5

NOTE

It is not recommended to use other materials or devices than specified 
in these instructions for use. 

8.2  Procedure

8.2.1  Sample preparation
The AltoStar® HAV RT-PCR Kit 1.5 was validated using the AltoStar® AM16 in 
combination with the AltoStar® Purification Kit 1.5.

Alternative nucleic acid extraction systems and kits might also be appropriate. The 
suitability of the nucleic acid extraction procedure for use with the AltoStar® HAV 
RT-PCR Kit 1.5 has to be validated by the user.

The AltoStar® HAV RT-PCR Kit 1.5 has to be used with a heterologous IC (AltoStar® 
Internal Control 1.5), which allows to control the sample preparation procedure 
(nucleic acid extraction) and the following PCR.

•	 When using other methods for nucleic acid extraction than the AltoStar® AM16 
in combination with the AltoStar® Purification Kit 1.5 the IC has to be added 
during the lysis step of the nucleic acid extraction procedure.

•	 The IC should always be added to the sample/lysis buffer mixture.

•	 The volume of the IC which has to be added, always and only depends on the 
elution volume. It represents 50 % of the elution volume. For instance, if the 
nucleic acid is going to be eluted in 60 µl of elution buffer or water, 30 µl of IC 
per sample must be added into the sample/lysis buffer mixture.

CAUTION

Storage of eluates under wrong conditions may lead to degradation of 
the HAV target sequence and could compromise product performance.
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8.2.2  Master mix setup
All components of the AltoStar® HAV RT-PCR Kit 1.5 and samples should be thawed 
completely, mixed (by pipetting or gentle vortexing) and centrifuged briefly before 
use. Set up the master mix according to the following pipetting scheme:

Table   10: Pipetting scheme (master mix setup)

Number of reactions (rxns) 1 12

Master A 5 µl 60 µl

Master B 15 µl 180 µl

Volume master mix 20 µl 240 µl

CAUTION

Do not use different volumes of Master A and Master B for master 
mix setup than specified in these instructions for use, as this could 
compromise product performance.

CAUTION

A lack of centrifugation of the product components after thawing 
may cause contamination with reagent residues in the lids and could 
compromise product performance.

8.2.3  Reaction setup
1.	 Pipette 20 µl of the master mix into each required well of an appropriate optical 

96-well PCR plate or an appropriate optical reaction tube.

2.	 Add 10 µl of the sample (eluate from the nucleic acid extraction) or 10 µl of the 
controls (PC or NTC).
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Table   11: Pipetting scheme (reaction setup)

Reaction setup

Master mix 20 µl

Sample or control 10 µl

Total volume 30 µl

3.	 Make sure that at least 1 PC and 1 NTC is used per run.

4.	 Thoroughly mix the samples and controls with the master mix by pipetting up 
and down.

5.	 Close the 96-well PCR plate with a PCR Plate Sealing Foil and the reaction 
tubes with appropriate lids (see chapter 8.1 Material and devices required but 
not provided).

6.	 Centrifuge the 96-well PCR plate in a centrifuge with a microtiter plate rotor for 
30 seconds at approximately 1,000 x g (~ 3,000 rpm).

After completion of the PCR setup, the PCR mix is stable at room temperature 
(max. +30 °C) for 30 minutes.

CAUTION

Do not exceed the PCR mix storage time, as this could compromise 
product performance.

CAUTION

Do not mix up samples or sample IDs during PCR setup or transfer to 
the PCR instrument. This could lead to false positive or false negative 
results due to incorrect assignment of the samples.
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8.2.4  PCR run

8.2.4.1  Programming the real-time PCR instrument
For basic information regarding the setup and programming of the different real-
time PCR instruments, refer to the instructions for use of the respective instrument.

For detailed programming instructions regarding the use of the AltoStar® HAV 
RT-PCR Kit 1.5 on specific real-time PCR instruments, contact altona Diagnostics 
technical support (see chapter 12. Technical support).

8.2.4.2  Run settings
Define the following basic settings:

Table   12: Run settings

Settings

Reaction volume 30 µl

Ramp rate Default

Passive reference* ROX™

*	 If applicable

Define the following fluorescence detectors (dyes):

Table   13: Fluorescence detectors

Target Detector name Reporter Quencher

HAV HAV FAM™ (None)

IC Internal Control JOE™ (None)
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Define the following temperature profile and dye acquisition:

Table   14: Temperature profile and dye acquisition

Stage
Cycle 

repeats
Acquisition

Temperature 
[°C]

Time 
[min:s]

Reverse 
transcription

Hold 1 - 55 20:00

Denaturation Hold 1 - 95 02:00

Amplification Cycling 45

- 95 00:15

Yes 55 00:45

- 72 00:15

CAUTION

Do not use other cycling conditions than specified in these instructions 
for use, as this could compromise product performance.

8.2.5  Data analysis
For basic information regarding data analysis on specific real-time PCR instruments, 
refer to the instructions for use of the respective instrument.

For detailed instructions regarding the analysis of the data generated with the 
AltoStar® HAV RT-PCR Kit 1.5 on different real-time PCR instruments, contact 
altona Diagnostics technical support (see chapter 12. Technical support).

Criteria for validity of diagnostic PCR runs and result interpretation regardless of the 
real-time PCR instrument are described in chapters 7.6.8.2 Validity of a diagnostic 
PCR run and 7.6.8.3 Validity of results for a sample, chapter 7.6.10.1 Manual 
interpretation of results and table 9.
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CAUTION

Do not use other control settings for data analysis than specified in 
these instructions for use, as this could cause incorrect IVD examination 
results. 

CAUTION

As with any diagnostic test, results shall be interpreted in consideration 
of all clinical and laboratory findings.

9.  Performance data
The performance of the AltoStar® HAV RT-PCR Kit 1.5 was evaluated using 
the 2nd and 3rd WHO International Standard for hepatitis A virus for Nucleic Acid 
Amplification Techniques (NIBSC code: 00/562 and 15/276, respectively) and HAV 
standard material calibrated against the WHO International Standard.

9.1  Plasma

9.1.1  Analytical sensitivity
For the determination of the limit of detection (LoD) a dilution series of the 3rd WHO 
International Standard for hepatitis A virus for Nucleic Acid Amplification Techniques 
(NIBSC code: 15/276) in plasma ranging from 1.00E+02 to 2.50E-01 IU/ml was 
generated.

Each dilution was tested in 8 replicates in 3 different runs (total n = 24 per dilution) 
using combinations of:

•	 3 AltoStar® HAV RT-PCR Kit 1.5 lots

•	 3 AltoStar® Purification Kit 1.5 lots

•	 3 AltoStar® Internal Control 1.5 lots

•	 3 AltoStar® AM16 instruments

•	 3 CFX96™ DW Dx instruments
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Data from all runs were combined and a probit analysis was performed to determine 
the 95 % LoD value.

Table   15: PCR results used for the calculation of the analytical sensitivity of the AltoStar® 
HAV RT-PCR Kit 1.5

Concentration 
[IU/ml]

N [total] N [positive] Hit rate [%]

1.00E+02 24 24 100

5.00E+01 24 24 100

2.50E+01 24 24 100

1.00E+01 24 24 100

5.00E+00 24 23 96

2.50E+00 24 16 67

1.00E+00 24 12 50

5.00E-01 24 4 17

2.50E-01 24 3 13

The LoD of the AltoStar® HAV RT-PCR Kit 1.5 for the detection of HAV in plasma is 
6.31 IU/ml (95 % confidence interval: 4.17–11.99 IU/ml).

9.1.2  Analytical specificity
The analytical specificity of the AltoStar® HAV RT-PCR Kit 1.5 is ensured 
by the thorough selection of the oligonucleotides (primers and probes). The 
oligonucleotides were checked by sequence comparison analysis against publicly 
available sequences to ensure that all relevant HAV genotypes will be detected.

For the verification of the analytical specificity of the AltoStar® HAV RT-PCR Kit 1.5 
the following experiments were performed (see chapters 9.1.2.1 Negative samples 
to 9.1.2.3 Cross-reactivity).
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9.1.2.1  Negative samples
35 HAV negative plasma samples from individual donors were tested with the 
AltoStar® HAV RT-PCR Kit 1.5. All (35 out of 35) samples were tested negative for 
HAV specific RNA and positive for the IC. The analytical specificity of the AltoStar® 
HAV RT-PCR Kit 1.5 for plasma samples is ≥ 95 %.

9.1.2.2  Interfering substances
To evaluate the influence of potentially interfering endogenous substances on the 
performance of the AltoStar® HAV RT-PCR Kit 1.5 selected substances were spiked 
in plasma samples. These plasma samples contained HAV in a concentration of the 
3 x LoD (1.90E+01 IU/ml) and no HAV, respectively.

Results obtained for samples containing potentially interfering substances were 
compared to results generated for plasma samples containing no spiked interferent. 
Each sample was processed in 3 replicates.

No interference was observed for samples containing elevated levels of:

•	 Endogenous substances

	◦ Bilirubin

	◦ Hemoglobin

	◦ Human genomic DNA

	◦ Human serum albumin 

	◦ Triglycerides

CAUTION

The presence of PCR inhibitors (e.g. heparin) could cause false negative 
or invalid results.
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9.1.2.3  Cross-reactivity
The analytical specificity of the AltoStar® HAV RT-PCR Kit 1.5 with respect to cross-
reactivity with other pathogens than HAV was evaluated by testing:

•	 Viruses related to HAV

•	 Viruses causing similar symptoms as an infection with HAV

•	 Viruses likely to be present in patients suffering from a HAV infection

The AltoStar® HAV RT-PCR Kit 1.5 did not cross-react with any of the following 
pathogens:

•	 Coxsackievirus A3

•	 Cytomegalovirus (CMV)

•	 Enterovirus 71

•	 Epstein-Barr virus (EBV)

•	 Hepatitis B virus (HBV)

•	 Hepatitis C virus (HCV)

•	 Hepatitis E virus (HEV)

•	 Herpes simplex virus 1 (HSV-1)

•	 Herpes simplex virus 2 (HSV-2)

•	 Human immunodeficiency virus 1 
(HIV-1)

•	 Parvovirus B19

•	 Rubella virus

•	 Rubulavirus (RuV)

•	 Varicella-Zoster virus (VZV)

•	 Yellow fever virus

CAUTION

In case the sample contains other pathogens than HAV, competition with 
the target amplification or cross-reactivities may occur, causing incorrect 
IVD examination results.
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9.1.3  Reactivity
Specificity of the AltoStar® HAV RT-PCR Kit 1.5 with respect to the detection of HAV 
genotypes is foremost ensured by the selection of the primers and probes. To verify 
that the AltoStar® HAV RT-PCR Kit 1.5 allows the detection of other HAV genotypes 
than HAV 1a [2nd WHO International Standard for hepatitis A virus (NIBSC code: 
00/562)] and 1b [3rd WHO International Standard for hepatitis A virus (NIBSC code: 
15/276)], HAV 2a und 3a were tested with the AltoStar® HAV RT-PCR Kit 1.5. HAV 
2a and 3a were detected positive with the AltoStar® HAV RT-PCR Kit 1.5.

CAUTION

Potential mutations within the target regions of the HAV genome covered 
by primers and/or probes used in the kit may result in failure to detect 
the presence of the pathogen.

9.1.4  Precision
Precision of the AltoStar® HAV RT-PCR Kit 1.5 was evaluated using a panel 
consisting of:

•	 1 HAV high positive (3.15E+02 IU/ml) plasma sample

•	 1 HAV low positive [1.90E+01 IU/ml (3 x LoD)] plasma sample

•	 1 HAV negative plasma sample

Each panel member was tested in 6 replicates per run.

5 runs were performed on 5 different days using combinations of:

•	 3 AltoStar® HAV RT-PCR Kit 1.5 lots

•	 3 AltoStar® Purification Kit 1.5 lots

•	 3 AltoStar® Internal Control 1.5 lots

•	 3 AltoStar® AM16 instruments

•	 3 CFX96™ DW Dx instruments
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Repeatability (intra-run variability), inter-lot variability and reproducibility (total 
variability) were determined based on:

•	 Values for the HAV high positive samples (see table 16)

•	 Threshold cycle (Cq*) values for the IC in the HAV negative samples (see 
table 17)

*	 Please note that the chosen term Cq is equivalent to the designation of Ct, which might be 
used by other cyclers than the CFX96™ Deep Well Dx System (Bio-Rad).

Table   16: Precision data (CV % based on Cq  values) for HAV high positive plasma 
samples

HAV high positive sample  
(3.15E+02 IU/ml)

Intra-run variability 0.17–0.31

Inter-lot variability 0.44

Total variability 0.91

All samples tested at 3 x LoD (low positive samples) were detected positive.

Table   17: Precision data (CV % based on Cq values) for the IC in HAV negative plasma 
samples

IC

Intra-run variability 0.17–0.37

Inter-lot variability 0.64

Total variability 0.67

9.1.5  Total failure rate
The robustness of the AltoStar® HAV RT-PCR Kit 1.5 was assessed by testing 33 
HAV negative plasma samples from individual donors spiked with HAV to a final 
concentration of the 3 x LoD (1.90E+01 IU/ml). All (33 out of 33) samples were 
tested positive in the HAV specific fluorescence detection channel (FAM™).
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9.1.6  Carry over
Carry over is mostly a workflow dependent risk and independent of the PCR assay 
used. For the AltoStar® Workflow the AltoStar® Parvovirus B19 PCR Kit 1.5 was 
used as exemplary model. Potential cross-contamination through carry over from 
high positive samples was evaluated by testing alternating parvovirus B19 high 
positive (1.00E+07 IU/ml) and negative samples (n = 44 each per run; 2 runs) with 
the AltoStar® Parvovirus B19 PCR Kit 1.5. No carry over was observed, i.e. all 
parvovirus B19 negative samples were tested negative.

9.1.7  Clinical performance
The AltoStar® HAV RT-PCR Kit 1.5 was evaluated in a comparative study with the 
CE-marked AmpliSens® HAV-FRT PCR Kit (AmpliSens Ecoli s.r.o.). Retrospectively, 
145 human plasma samples were tested in parallel:

The AmpliSens® HAV-FRT PCR Kit (AmpliSens Ecoli s.r.o.) was used in combination 
with the NucliSENS® easyMAG instrument (bioMérieux) and the RotorGene® 6000 
instrument (QIAGEN), respectively the Mx3000P instrument (Agilent).

The AltoStar® HAV RT-PCR Kit 1.5 was used in combination with the AltoStar® 
Purification Kit 1.5 and the AltoStar® Internal Control 1.5 on the AltoStar® AM16 and 
the CFX96™ DW Dx.

For the qualitative analysis all samples with an invalid result for one or both assays 
were excluded.

Results for the remaining 138 samples are shown in table 18.
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Table   18: Results of the evaluation of the diagnostic sensitivity and specificity for HAV in 
plasma samples 

AmpliSens® HAV-FRT PCR Kit (AmpliSens Ecoli s.r.o.)

POSITIVE NEGATIVE

A
lto

St
ar

®
 H

AV
 R

T-
PC

R
 

K
it 

1.
5 PO

SI
TI

VE

68 1

N
EG

AT
IV

E

0 69

The diagnostic sensitivity and specificity of the AltoStar® HAV RT-PCR Kit 1.5 
compared to the AmpliSens® HAV-FRT PCR Kit (AmpliSens Ecoli s.r.o.) were 100 % 
and 98.57 %, respectively.

10.  Disposal
Dispose of hazardous and biological waste in compliance with local and national 
regulations. Leftover product components and waste should not be allowed to enter 
sewage, water courses or the soil.

CAUTION

Always treat samples as infectious and (bio-)hazardous material in 
accordance with safety and laboratory procedures. For sample material 
spills promptly use an appropriate disinfectant. Handle contaminated 
materials as biohazardous.

CAUTION

Disposal of hazardous and biological waste shall comply with local and 
national regulations to avoid environmental contamination.
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NOTE

The PCR plate must be disposed of in a sealed state since the PCR 
Plate Sealing Foil cannot be removed.

11.  Quality control
In accordance with the altona Diagnostics GmbH EN ISO 13485-certified Quality 
Management System, each lot of AltoStar® HAV RT-PCR Kit 1.5 is tested against 
predetermined specifications to ensure consistent product quality.

12.  Technical support
For customer support, contact altona Diagnostics technical support:

e-mail: 	 support@altona-diagnostics.com

phone: 	 +49-(0)40-5480676-0

NOTE

Any serious incident that has occurred in relation to this product shall 
be reported to altona Diagnostics and the competent authority of your 
country.

13.  Literature
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Edition. Mosby, 2010.
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14.  Trademarks and disclaimers
4s3™ (4titude); AltoStar® (altona Diagnostics); AmpliSens® (AmpliSens Ecoli 
s.r.o.); ABI Prism®, QuantStudio™ (Applied Biosystems); NucliSENS® (bioMérieux); 
CFX96™, CFX Manager™ (Bio-Rad); Rotor-Gene® (QIAGEN); LOINC® (Regenstrief 
Institute, Inc.); LightCycler® (Roche); FAM™, JOE™, MicroAmp™, VIC™ (Thermo 
Fisher Scientific).

Registered names, trademarks, etc. used in this document, even if not specifically 
marked as such, are not to be considered unprotected by law.

The AltoStar® HAV RT-PCR Kit 1.5 is a CE-marked diagnostic kit according to the 
European in vitro diagnostic directive 98/79/EC.

Product not licensed with Health Canada and not FDA cleared or approved.

Not available in all countries.

© 2022 altona Diagnostics GmbH; all rights reserved.
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15.  Symbols
Symbol Explanation

V
In vitro diagnostic medical device

*
Global Trade Item Number

g
Batch code

.
Content

/
Cap color

h
Catalogue number

#
Number

,
Component

i
Consult instructions for use

X

Contains sufficient for "n" tests/reactions 
(rxns)

l
Temperature limit

H
Use-by date

M
Manufacturer

Y
Caution

&
Material number
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Symbol Explanation

A
Version

=
Note

)
Contains biological material of animal origin
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16.  Assay protocol for the AltoStar® Connect software and 
information for LIMS integration

The 2D barcode in figure 15 is to be used for installing the latest assay protocol 
for use of the AltoStar® HAV RT-PCR Kit 1.5 on the AltoStar® AM16. The barcode 
can only be scanned in printed form. You can scan the barcode directly from the 
manual or print it on a separate sheet. Please note that the size of the print affects 
the scannability of the barcode. Make sure to scale the size to 100 %. For scanning, 
aim the scanner to the red line on the barcode. For details on management of assay 
protocols, please refer to the respective chapter in the instructions for use of the 
AltoStar® Connect software. For information for LIMS integration, see table 20.

Figure   15: Assay protocol barcode for the AltoStar® HAV RT-PCR Kit 1.5

Table   19: Changelog for the assay protocol

Protocol version Release updates

1 Initial version
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Table   20: Information for LIMS integration

Usage Data

Test order (LIMS → AltoStar® AM16) AltoStar HAV RT-PCR Kit 1.5

Test result (CFX96™ DW Dx → LIMS) unit N/A

Test result (CFX96™ DW Dx → LIMS) 
channel 1

HAV

Test result (CFX96™ DW Dx → LIMS) 
channel 2

Internal Control

For LOINC® (Logical Observation Identifiers Names and Codes) please refer to the 
altona Diagnostics GmbH website (www.altona-diagnostics.com) or contact altona 
Diagnostics technical support (see chapter 12. Technical support).
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17.  Revision history
Table   21: Revision history

Identifier
Date of issue  
[month/year]

Modifications

MAN-AS0241540-
EN-S02

04/2022

•	 Chapter 7.4: addition of the new product number 
for the AltoStar® Purification Kit 1.5 (PK15-46) 
and the AltoStar® Internal Control 1.5 (IC15-46)

•	 Chapters 7.6.7.3 and 7.6.8: update of 
figures 10, 11 and 12

•	 Chapter 9: streamlinig of wording
•	 Chapter 9.1.4: addition of 1 HAV low positive 

plasma sample at the concentration of 3 x LoD 
(1.90E+01 IU/ml) to the testpanel and 6 instead 
of 4 replicates were tested

•	 Additional editorial changes

MAN-AS0241540-
EN-S03

11/2022
•	 Chapter 9: implementation of additional study 

data
•	 Additional editorial changes
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